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I INTRODUCTION

Purpose

This User Guide contains an introduction, installation, and user information section for the
OfficeServ 7000 Series Installation Tool. The Installation Tool is a PC-based MMC (Man Machine
Communication) application designed to configure the OfficeServ 7000 Series key phone systems.

Document Content and Organization

This User Guide is comprised of five chapters.

CHAPTER 1 : Installation Tool: Introduction

In this chapter, a brief introduction to the Installation Tool application and its main functions are
discussed.

CHAPTER 2 : Installation Tool: Installing the Application

In this chapter, the installation environment and specific directions on how to install/uninstall the
Installation Tool application are discussed.

CHAPTER 3 : Installation Tool: How To Use
In this chapter, the steps on how to use the Installation Tool and use its menus are discussed in detail.

CHAPTER 4 : Application Windows and Programming Example

In this chapter, the Application Windows (which are used to set the OfficeServ 7000 Series
parameters) are discussed. Examples of some programming steps are also provided.

CHAPTER 5 : MMC and Installation Tool Cross Reference

In this chapter, cross reference information between the Installation Tool Menu numbers and MMC
numbers are provided.
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Conventions

The following types of paragraphs contain special information that must be carefully read and
thoroughly understood. Such information may or may not be enclosed in a rectangular box,
separating it from the main text, but will always be preceded by an icon and/or a bold title.

WARNING

WARNING

Provides information or instructions that the reader should follow in order to avoid personal
injury or fatality.

CAUTION

CAUTION

Provides information or instructions that the reader should follow in order to avoid a service
failure or damage to the system.

Ve

CHECK

CHECKPOINT

Provides the operator with checkpoints for stable system operation.

N

NOTE

NOTE

Indicates additional information as a reference.

EXAMPLES

Indication that there is a application example which should be remembered.

© SAMSUNG Telecommunications America, L.P. 03/2008 [\
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Console Window Output

+ The lined box with ‘Courier New’ font will be used to distinguish between the main content
and console output window text.

+ ‘Bold Courier New’ font will indicate the value entered by the operator on the console
window.

Revision History

EDITION DATE OF ISSUE REMARKS

00 03. 2008. Original
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I PRECAUTIONS

In order to ensure product safety and proper operation, information presented with the following icons should be carefully
read before installing or using the product:

Symbols

Caution

Indication of a general caution.

Restriction

Indication for prohibiting an action for a product.

Instruction
Indication for commanding a specifically required action.

© SAMSUNG Telecommunications America, L.P. 03/2008 VI
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A CAUTION

Caution when installing/uninstalling the IT
Existing data may be lost during installation/uninstallation of the IT. Backup all OfficeServ

system data before proceeding.

Caution when uploading

A When uploading an OfficeServ system database, the card slot configuration of the database
being uploaded should be identical to the key phone system's card slot configuration. It may
be necessary to reboot the OfficeServ 7000 system after the upload procedure (the technician
will be prompted with a message.) To protect memory data from accidental deletion, please
ensure that the MP10/MCP/MP40 card's backup switch is set to the [ON] position.
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I CHAPTER 1 Installation Tool: Introduction

In this chapter, a brief introduction to the Installation Tool application and its main functions are discussed.

Introduction to the Installation Tool

The Installation Tool (IT) is a PC-based Man Machine Communication (MMC) program designed to
help phone system administrators by eliminating multiple types of system programming utilities
(Web MMC, OSM.) The IT works on a PC (see page 3 for PC OS requirements) and connects to all
the OfficeServ 7000 Series systems (see page 4 for OfficeServ software requirements) over a LAN,
WAN, or modem connection.

This single application solution makes it easy and convenient for system administrators, because the
IT’s user-friendly GUI can be utilized to change system, station, and trunk parameters, save or
restore system databases, and perform file management functions (write files to the Smart Media or
MMC Plus Cards) on all of the OfficeServ 7000 Series systems.

With IT it is now possible to compare OfficeServ 7000 Series databases, which makes it simple for
system administrators to verify and pinpoint modifications in the system programming from one
database to another. The IT can also be configured with convenient bookmarks, which offers simple
one click access to the most commonly used parameters.

Although the programming structure of the IT has moved away from a purely MMC design it is still
possible to correlate the IT Menu numbers with specific MMC numbers. By using the “by MMC”
search field and “MMC Mouse Over” feature it is easy to determine which IT Menu belongs to
which MMC number.

Functionality

Easy Management of System Databases

The IT manages all of the OfficeServ 7000 key phone systems from a single application. Phone
system administrators use the IT Link Control window to log into any OfficeServ 7000 Series
system. This eliminates the need of requiring multiple types of system programming utilities (Web
MMC, OSM.)

Uploading and Downloading OfficeServ 7000 Series System Databases

The IT can be used to download an OfficeServ 7000 Series key phone system database to a PC or to
upload a key phone system database system from a PC to an OfficeServ 7000 key phone system.

© SAMSUNG Telecommunications America, L.P. 03/2008 1



Installation Tool User Guide

Offline Database Programming

The IT can be used to download an OfficeServ 7000 Series key phone system database. Once
downloaded, the phone system administrator can make programming changes to the downloaded
database while off-line. The modified database can then be uploaded to an OfficeServ 7000 key
phone system. (The card configuration of the OfficeServ 7000 Series system database and
OfficeServ 7000 Series system must match.)

Uploading and Deleting OfficeServ Application Files

The IT can be used to upload OfficeServ application files to the OfficeServ 7000 key phone system
or to delete an OfficeServ application file from the system. These files are used for upgrades to the
Operating System of an OfficeServ 7000 Series system, and for LCP, LP40, and TEPRI card
software upgrades.

Local and Remote Administration

The IT works on a PC running Windows 98, 2000, XP, and Vista, and connects to all the OfficeServ
7000 Series systems running MP10/MCP/MP40 version 4.XX or higher (see page 4 for OfficeServ
software requirements) over a LAN, WAN, or modem connection.

OfficeServ 7000 Database Comparing

The IT can compare OfficeServ 7000 Series databases. This valuable tool makes it simple for phone
system administrators to verify and pinpoint modifications in the system programming.The
databases being compared must be from the same OfficeServ 7000 Series type. (OfficeServ 7400 to
OfficeServ 7400.)

Menu Bookmarks

For IT menus that are accessed on most OfficeServ 7000 Series system installations (such as menu
2.1.2 - used for entering the IP Address of the MP10, MCP, and MP40) the IT can be configured
with menu bookmarks, which offer simple one-click access.

Search by MMC or by IT Menu Number

The IT has a search window that can be set to search by MMC number or by IT menu number. This
feature makes it is easy for the phone system administrators to determine which IT menu belongs to
which MMC number and vice versa.

© SAMSUNG Telecommunications America, L.P. 03/2008 2
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CHAPTER 2 Installation Tool: Installing the
Application

In this chapter, the installation environment and specific directions on how to install/or uninstall the
Installation Tool (IT) application are discussed.

Installation Environment

This section provides a list of the IT installation package items as well as the minimum PC
requirements for a successful installation.

Package Items

« Installation File: IT(yy.mm.dd.)zip
+ User Guide

Package

The file name formatting IT(yy.mm.dd.)zip: yy.mm.dd refers to the release date/version.
NOTE (ex: IT(070615.)zip)

Minimum PC Requirements
Listed below are the minimum PC requirements for the IT to function properly.

H/W Requirement
PC CPU Pentium Il or faster
Main Memory Minimum of 512 MB

HDD Drive At least 30 MB

Operating Systems Microsoft Windows 98
Microsoft Windows 2000 (all editions)
Microsoft Windows XP (all editions)

Microsoft Windows Vista (all editions)

Modem 1,200~115,200 baud rate when using a modem connection to
the OfficeServ 7000 system

LAN (Ethernet) 10/100 Base-T when using a LAN/Internet connection to the
OfficeServ 7000 system

© SAMSUNG Telecommunications America, L.P. 03/2008 3
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Minimum OfficeServ 7000 Series Software Version Requirements

Listed below are the minimum phone system software requirements for the IT to function properly.

H/W Minimum Software Version Requirement
7100 MP10 Version 4.04a
7200 MCP Version 4.14k
7400 MP40 Version 4.14k

When installing or uninstalling the IT

Samsung recommends backing up all 7000 Series System databases to a safe location
caution  before proceeding with an installation uninstallation of the IT.

© SAMSUNG Telecommunications America, L.P.
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Installing the Application

The installation procedure for the IT application is as follows:

Install/Uninstall Procedure

s The windows seen during the installation of the IT application may vary depending upon the
NOTE Operating System being used on the PC. The Install and Uninstall process documented in the
manual was gathered using the Windows XP Professional Operating System.

1 Unzip the installation file if needed and then launch the ‘Setup.exe’ file. The following setup
window will be displayed:

InstallShield Wizard @

Welcome to the InstallShield Wizard for
Installation_T ool

The InstallS hield® \Wizard will install Ingtallation_T ool on
your computer. To continue, click Next.

Cancel |

2. On the <Welcome> window, click on the [Next>] button to initiate the installation process.

© SAMSUNG Telecommunications America, L.P. 03/2008 5
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3. On the <Choose Destination Location™> window, click on the [Browse...] button and select the
location where the application is to be installed. Click on the [Next>] button to continue the
installation.

InstallShield Wizard

Choose Destination Location

Select folder where Setup will install files.

Setup will ingtall Installation_Tool in the following folder.

Tainstall to this folder, click Next. Toinstall to a different folder, click Browse and select
another folder.

Destination Folder

C:h ASamsung Electronics\nstallation_T ool Browse. .

< Back Cancel ‘

4. The following progression bar is displayed to indicate that the application is being installed.
To cancel the installation, click on the [Cancel] button.

InstallShield Wizard

Setup Status

Installation_Tool Setup is performing the requested operations.

602%

© SAMSUNG Telecommunications America, L.P. 03/2008 6
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5.  When the InstallShield Wizard finishes installing the application, the following window will be
displayed:

InstallShield Wizard

InstallShield Wizard Complete

Setup hasz finished instaling Installation_T ool on your
computer.

6. Click on the [Finish] button to close the window.

© SAMSUNG Telecommunications America, L.P. 03/2008 7



Uninstalling the Application

To uninstall the IT application, proceed as follows:

1

2.

Installation Tool User Guide

From the Windows Taskbar, click on [Start] - [Settings] - [Control Panel] >
[Add/Remove Applications]. From the list, select [Imstallation Tool] and click on

[Change/Remove].

ER Add/Remove Programs L o ] [
Currertly installed pragrams: Sort by:l Mame -

‘9 Apache Tomcat 5.5 (remove only) Size 12,9MB &

B Device File Uploader Size 2.76MB
i) Hotfix for MDAC 2,53 (KE911562)

-,lé'- Installation_Tool

hange/Remove

é 1Z5E Development Kit 5.0 Update ¢ Size ZE0MB
é 125E Runtime Environment 5.0 Update 4 Size: 151MB
é 125E Runtime Environment 5.0 Update 6 Size: 145MB
ﬂ Microsoft \NET Framework 1.1 Size: 36.6MB
% Microsoft OFfice 97, Professional Edition Size: 108MB
[=] Microsoft Wisual Studin 6.0 Enterprise Edition Size: 358MB
Microsoft Web Publishing Wizard 1.53 Size: 136KB
E.é OfficeSery Manager Launch Pad Uninstall

i osm_zzon

ﬁ PkaMaker j
5 O I B - SR

The following progression bar will be displayed to indicate that the IT application is being

uninstalled:

InstallShield Yizard X

Setup Status

Installation_Toal Setup iz performing the requested operations.

0%

© SAMSUNG Telecommunications America, L.P. 03/2008
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3. When the InstallShield Wizard finishes uninstalling the IT application, the following window
will be displayed:

InstallShield Wizard

Maintenance Complete

InstallShield ‘wizard haz finizhed performing maintenance
operations on | nstallation_Toal.

4, Click on the [Finish] button to close the window.

© SAMSUNG Telecommunications America, L.P. 03/2008 9



I CHAPTER 3 Installation Tool: Usage

In this chapter, the steps on how to use the Installation Tool and use its menus are discussed in detail.

Launching the Installation Tool

After a successful installation of the IT application, it is ready to be launched.

There are two different ways to launch the IT application:

+ From the Windows Taskbar, click on [Start] > [All Programs] > [Samsung Application
Program Module] - ‘Installation Tool’.

« From the desktop, double-click the @ icon.

When the IT application is launched, the following window will be displayed:

4 Installation Tool

Copyright/€2006 Samsung Electron .- To,Ltd.

The Installation Tool Version number is
displayed in the lower right hand corner of
the launch window.

Once Installation Tool has been opened, the version level may also be viewed by selecting “Help”
and “about”.

© SAMSUNG Telecommunications America, L.P. 03/2008
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Window Layout

Once the login process has been completed, the main window of the IT application will be
displayed:
-lglx]

Swstern  File  Option Ukl Window  Help

C-% % %2 om3-2-K-0|6
Port Base I

B Expand All Menu ltem(s)

| None |Mone | Mone | Mone None 7/23/2007 | 231PM

The details for the window layout are listed in the following table.

Window Layout Details

Menu Displays all the menu functions used in the application
(System, File, Option, Util, Window, and Help.)

Toolbar Displays the most commonly used functions (The icons in the
Toolbar are covered in the IT Main Window Toolbar Icon
section of this User Guide.

Main Window Displays the selected function on the window.
Menu Window Displays the parameter window and the page index.
Status Bar Displays information such as online time/user DB file name,

system type/locale/version, date and time.

© SAMSUNG Telecommunications America, L.P. 03/2008 11
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IT Main Window Toolbar Icon

The IT Toolbar and various windows have several icons that are used to perform various functions.
The following table presents several details of the icons found throughout the IT.

Details

Connect: Used to connect the user’s PC with the key phone system
(MP10/MCP/MP40) selected in the Link Control window.

Disconnect: Used to disconnect the user’s PC from the key phone
system being managed.

Link Control: Used to open the Link Control window which is used to
configure the OfficeServ 7000 sites being managed.

Download DB: Used to download an OfficeServ 7000 Series system
database file from the MP10/MCP/MP40 to a user’s PC.

Upload DB: Used to upload an OfficeServ 7000 Series system database
file from the user’s PC to an MP10/MCP/MP40.

Open: Used to open an OfficeServ 7000 Series database file.

Close: Used to close an OfficeServ 7000 Series database file.

File Control: Used to upload/delete a file on the OfficeServ 7000 Series
system.

Bookmark: Used to manage bookmarked windows/files/displays of the
OfficeServ 7000 Series page index.

History: Used to delete the historical information on previously opened
windows/displays of the page index.

Exit: Used to terminate the IT application.

Information: Used to display the IT application version number and
creation date.

O & 5L L | < ED 8 <8
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System Menu

The [System] menu provides functions such as connecting or disconnecting from an OfficeServ
7000 Series system, uploading and downloading the database from an OfficeServ 7000 Series
system, and opening the Link Control window.

Conneck Chrl+C
Djscanmect Chrl+D

Download DB Fronm System
lplpad DB To System

Link Control

Using the [System] Menu

k The [System] menu’s [Link Control] can only be used when the IT is not connected to a
NOTE system. The [Download DB From System] and [Upload DB To System] options can only be
used when logged into a system.

Link Control

Site List

In order to connect to an OfficeServ 7000 Series system the site information must be entered into
the Link Control. The [Link Control] sub-menu is used to configure the communication
environment between the IT and the OfficeServ 7000 Series key phone system(s.) Click on the
[System] = [Link Control] sub-menu and the following window will be displayed:

]
Site List 1 Option 1
Link S DataFort /| FileFart/
Mo Marme Type | DESUEON | ooppon | Baudrate

Mame I & |
Link Type ILAN 'l
P Address | oeee|

DefaultPort ¥ [ DetaPat| 5090 | FilePort| G003 |  Undate |

Al | Close |

Refer to the following table for a description of each Link Control parameter.

© SAMSUNG Telecommunications America, L.P. 03/2008 13
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Field

Details

Name

Used to enter the name of the customer site.

Link Type

Used to select the connection 1. LAN - Local Area
type for the PC doing IT Network
administration. 2. MODEM (Not
supported on the OS
7200.)

IP Address

If the Link type is set to LAN, this parameter can be modified.
Enter the IP Address assigned to the MP10/MCP/MP40.

Telephone

If the Link type is set to Modem, this parameter can be modified.
Enter the phone number associated to the OfficeServ 7000
Series system modem (Not supported on the OS 7200.)

Data Port

If the Link type is set to LAN, this parameter can be modified.
Enter the port number that the IT will use to connect to the
MP10/MCP/MP40 over the LAN connection (only use in
specific circumstances such as NAT.)

File Port

If the Link type is set to LAN, this parameter can be modified.
Enter the port number that the IT will use for file transfers to the
MP10/MCP/MP40 over the LAN connection (only use in
specific circumstances such as NAT.)

COM Port

If the Link type is set to Modem, this parameter can be modified.
Select the modem’s COM port.

Baud rate

If the Link type is set to Modem, this parameter can be modified.
Select the appropriate modem speed.

[Delete] Button

Used to delete the selected site information.

[Update] Button

Used to store the selected site information.

[Apply] Button

Used to select the site which the IT will connect to when the
[Connect] button is clicked.

[Close] Button

Used to close the Link Control window.

The Two [Link Type] Settings

From the <Link Control> window’s [Link Type] field, select one of the two following connection

methods.

+ Modem: Use the PC’s modem to connect to the key phone system.

(COM 1~10: We suggest using an external modem for this purpose.)

+ LAN: Use the PC’s LAN to connect to the key phone system.
(You may use a cross-over LAN cable to connect directly to the key phone system’s LAN port.

Alternatively, you may use a straight LAN cable to connect to the network.)

© SAMSUNG Telecommunications America, L.P. 03/2008 14
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If the Link Type for a particular site is set to LAN, an IP address must be obtained from the System
Administrator. This IP address may be programmed into the system using MMC 830. Once
programmed, the same IP address must be entered on the IP Address line in Link Control. Enter the
IP Address of the MP10/MCP/MP40 card and then click the [Update] button to save the change. If
different ports need to be used, then uncheck the [Default Port] box and then enter the appropriate
port information for the [Data Port] (MP10/MCP/MP40 Connectivity) and the [File Port] (Upload
Files to Storage Media.)

% Link Control

Site List T Option ]
Link N DataPort/| FilePort/
Mo MNarme Ty Destination COMPort | Baudrate
il 7100 Site & LaM  |216.62.86.101 |5080  |5003
2 7200 Site B LAM 21662.86.102 5040 5003

37400 Site C LAMN 216.62.86.103 5090 5003

Name  [7100SieA EAN-1

Link Type LAMN -

IPAddress  [216.62.86.101 Delete
DefeutPot | DataPort [5090] FilePart |5003]

Apphy | Close |

— Entering the system IP

@ The IP address field in the IT refers to the OfficeServ 7000 Series system’s IP address to
NOTE which the IT will connect. The information can be verified by logging into an OfficeServ 7000
Series system via KMMC, and then by viewing MMC 830 ‘ETHERNET PAR’.

Once a site is defined and highlighted in the top section of the <Link Control> window (like in the
picture above), simply click on the € | icon to connect to the MP10/MCP/MP40.

The & |icon is used to upload OfficeServ application files to the storage media.

In order to change a particular parameter on a defined site, highlight the site (like in the picture
above), modify the parameters on the botton part of the window, and then click the [Update] button.

© SAMSUNG Telecommunications America, L.P. 03/2008 15
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If the [Link Type] for a particular site is set to Modem, enter the COM port number, the baud rate,
and the telephone number for the modem connected to the MP10/MCP/MP40 and then click the

[Update] button to save the change.

Site List

Option

Mo MHarne

1(7100 Site A
2| 7200 Site B
3/7400 Site C

7400 Site D

Link
Type
LAN

Destination

216.62.86.101 5040 5003
216.62.86.102 5090 5003
216.62.86.103

A | 3726661212 COk1

DataPort /| FilePort/
COMPort | Baudrate

5080

Name 7400 Site D

Link Type MODER -
COM Port COM1 e

Telephone |E|?25551212

Baudrate 19200bps - Delete

Apply | Close |

Option

The [Option] tab may be selected to set additional information regarding the modem connection
(between the IT and the key phone system.)

x|
Site List 1 iOption: 1
hModem
BlelBen: |1— Dial Duration IT sec
INIT CMD |ATEF
Apply | Close |

Once a site is defined and displayed in the bottom section of the <Link Control> window, simply
click on the € | icon to connect to the MP10/MCP/MP40.

The = |icon is used to upload OfficeServ system files to the storage media.

Refer to the following table to configure the modem’s options:

© SAMSUNG Telecommunications America, L.P.
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Field Details

Dial Retry Used to set the number of attempts (dial counts) for the
modem connection.

Dial Duration Used to set the connection time (uptime) for the modem
connection.
INIT CMD Used to set the modem’s initialization command.
Connect

Once the OfficeServ site is defined in Link Control, use the [Connect] sub-menu to connect the IT
to an OfficeServ 7000 Series key phone system. Click on the [System] = [Connect] sub-menu and
the following window will be displayed:

zl

10 jadmin

Fassword

Enable ITenanH 'l
k. I Cancel |

Enter the correct ‘ID’ and ‘Password’ then click the [OK] button.
The IT then downloads the initial data and switches to on-line mode.

Entering the password

k After three unsuccessful login attempts, the IT application will automatically close. The default
NOTE values for the IT User ID and Password are admin and samsung.

© SAMSUNG Telecommunications America, L.P. 03/2008 17
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In order to secure the OfficeServ 7000 Series system from unauthorized access, it is highly
recommended that the default IT password be changed. This password is not correlated with any
password settings used in KMMC programming and must be done using the IT menu 2.1.7. If this
password is lost or forgotten, Samsung Technical Support must be contacted for assistance.

In addition to changing the IT password, menu 2.1.7 can be used to create (9) separate user accounts
with their own passwords. Each user account can be assigned a permission level (2-3.)

B & 0o & L - NG
217
Password
Admin [Newy
Caonfirm
1D Password Lewvel
1
z
3
4
Uszer c
B
7
8
4

The permission levels are defined in IT menu 5.13.5 which is used to allow or deny specific IT
menus.

B~ & 0l¢a| Y ILYEIE

Inddex kdenu Lser Lewel 2 User Lewel 3
2.1.0. System Selection Yes “res
211 System Information Yes s
21.2, LAMN Parameter “es “es
213 System Time Yes “es
2.1.4. License Key Yes r'es
2.1.5. Systermn Options Yes “es
2.1.5. 2%Mi Options Y'es Y'es
21.7. Connect User Profile “es “es
220 Cakinet Information “es “es
221, LCF Card “es “es
222 kGl Cards “es “Es
2.2.3 =i Card “es “es
224 WL Cards “es “ES
2.2.h, DLl Cards Y'es 'es
2.2.6, SL Cards “es “es
2.2.7. Analog Trunk Cards Yes r'es
2.2.8 Lniversal Trunk Cards “es “es
229 BRI Cards Yes “es
2.2.10. FRI Cards “es “es
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Disconnect

While in on-line mode, click on the [System] = [Disconnect] sub-menu to disconnect from the
OfficeServ 7000 Series system and switch to off-line mode.

Download DB From System (MP10/MCP/MP40)

This sub-menu is used to download the key phone system database to the user’s PC.

1. Click on the [System] - [Download DB From System] sub-menu. Once the <New
Database> window opens, either create a new file or select an existing one.

i
Save i I@ DB 7] « &% EB-

File name: || j Save I
i j Cancel

Save as lype: Ilnstallation Tool User Files(*.1UD]
v

2. When an existing database file is selected, the following window will be displayed:

DE Control =
The selected Filels) is duplicated.
Do wou want ko overwrite ik?
es Mo |

To overwrite the existing download file, click on the [Yes] button. Otherwise, click on the
[No] button to cancel the download.

© SAMSUNG Telecommunications America, L.P. 03/2008 19



Downloading a newly created file
When creating and downloading a new database file, the following window will be displayed:

4* New DB file... |

Systern |OS7100

Countee | LIS

| K [ K

Fassword |

Confirm

oK

| Cancel |

Installation Tool User Guide

On the <New DB file...> window, enter and confirm the Technician Level ‘Password’ of the

OfficeServ 7000 Series system being downloaded (Default password is 4321.)
3. After the download file is created, the following <DB Control> window will be displayed:

“4* DB Control

x|

~| V¥ All Select
Selected ltemis)  140/140

Select

Group Al

Kind Description
215 System Options
2.2.0. Cabinet Information
2.3.0 ¥irtual Cabinet Information
2.4.1. Port Information
2.8.0. Numbering Plan
22 LAN Parameter
5, WLAN Parameter
hi3 3. WLAN P Pool
B.2.5. WP Status
332 Metwork Dial Translation
3.3.4. Metworking Options
A4 1 Cmdiman T emimm

-

(R EEEREEEEE

I~ Venfy After Uploading

Download | Close |

4. Select the desired feature group to be downloaded. To download all the feature groups, click

on the [All Select] box. All feature groups are selected to be downloaded by default.

© SAMSUNG Telecommunications America, L.P.
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5. After selecting the desired feature blocks, click on the [Download] box. The following
window will be displayed as the IT application initiates the downloading process. To cancel the
download, simply click on the [Cancel] button.

4" DB Control - Download [00:00:01] ] |
Group  [Al =] ¥ Al Select
Selected ltern(s) 1407140
Kind Description Frogress | Size

i WLAN IF Fool 0 =

6.2.5. WIF Status 0 =

332 MNetwork Dial Translation 0 =

3.3.4. Metworking Options 0] =

4.1.1. Station Groups (0] =

421, Station Pair 0 =

bl System Information (8] =

2153 System Time (0] =

2.1.4. License Key 0%

215 Zwhi Options i
Fesult>>  Success: 15 Failure : 0 Warming 0

Downloading. .. Do:00:01

LTI ] 1%

6. When the download is finished, the following window will be displayed: Click on the [OK]
button to close the window.

x
@ The selected itemn(s) is downloaded successfully

Elapsed time [ 00:00:16 ]

Download Speeds

7l

Database download speeds will vary depending on type of connection and quality of

NOTE connection, For example, a 3 cabinet OfficeServ 7400 with a good WAN connection with
plenty of bandwidth will take approximately 30 seconds to download a database. The same
system with a modem connection will take around 10 minutes to download a database.
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Upload DB To System

While in the on-line mode, this sub-menu may be used to upload an OfficeServ 7000 Series system
database from the user’s PC to a key phone system.

1. Click on the [System] - [Upload DB To System] sub-menu. The following window will be

displayed:
penpatabase 2|
Lookln:l@DB j = [E] £F Ed-

057100_USA. IUD

File name: || j Open I
j Cancel |

" Files of type: Ilnstallation Tool User Files[*. UL
i

2. Select the appropriate .IUD file and then click the [Open] button to display the following login
window.

zl

Password ||

k. I Cancel |

In the <Login> window, enter the database file’s ‘Password’ to open the <DB Control> window
(Default paswword is 4321.)
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3. In the <DB Control> window, select the desired feature blocks to upload to the OfficeServ
7000 Series key phone system. To upload all feature blocks, click on the [All Select] button.

By default, all feature block menus are selected for uploading.

x
Gowy [T | Al Soloct
Selected ltern(s) 136 /136
Kind Description Select
215 System Options
220 Cabinet Information
230 Wirtual Cabinet Information
241, Fort Information
280 Mumbering Plan
e LAM Farameter
531 WA Parameter
553 WLAN IP Pool
E.25 WF Status
Fa IMetwark Dial Translation
334 Metwarking Options
A4 1 Cmdiman T vmim sl

[~ Verify After Uploading

Upload | Close |

4. Once the feature blocks are selected, click on the [Upload] button to initiate the uploading

process. To cancel the uploading process, click on the [Cancel] button.

x
Group  [all =] ¥ Al Select
Selected lter(s)  136/136
Kind Description Frogress | Size
6.2.5. WIF Status 0 g
332 Metwork Dial Translation (0] -
3.3.4. Metworking Options (o] =
4.1.1. Station Groups 0] 2
4.2.1. Station Pair (0] o
233 System Time (0] =
2.1.4. License Key (8] =
216 Sy Options 0 -
2.1.7. Connect User Profile Writing...
el LCP Card i
Fesult>>  Success: 16 Failure : 0 Warming 0
Uploading... Do:00:01 -
(TITIIIT] 1 12% |i Cancel
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5. When the uploading process has finished the following window will be displayed:
Click on the [OK] to close the window.

DB Contraol x|

@ The selected item(s) is uploaded successfully

Elapsed time [ 00:00:18 ]

Upload Speeds

7

Database upload speeds will vary depending on type of connection and quality of connnection,
NOTE For example, a 3 cabinet OfficeServ 7400 with a good WAN connection with plenty of
bandwidth will take approximately 30 seconds to upload a database. The same system with a
modem connection will take around 10 minutes to upload a database.

Upload DB - Verify After Upload

Within the <DB Control> window, the [Verify After Uploading] box may be checked. This
will make sure the IT application compares the database being uploaded to the key phone

system with the active database.

Once the IT has executed the ‘All Upload” = ‘All Download’ = ‘Compare’ process the

following result window will be displayed:

5,
Group  [Al x| ¥ All Select
Selected ltemis) 136/ 136
Kinel Description Frogress | Size
Gl Station Speed Dial 0 =
HaE.B Alarm Reminder (o] =
il Frogrammed Message 8] =

51510, |Text Message

51511, |Group Conference
51512, |Large LCD Options
G543 Executive State .
6.2.1. Connection Status o]

622 ITP Status 0 =
‘ Result>>  Success: 272 Failure : 0 aming 0 ‘
¥ Verfy After Uploading Whload | Close |
Step Description Elapsed Time | Result |
1 All Upload 00:00:18 S:136. F:0 . w0
2 All Download 00:00:16 5:136. F:0 . W0
3 | Compare 00:00:01 RO .AD.C3 @
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The Result information found within the <DB Control> window has the following meaning as
it pertains to the feature blocks being compared between databases:
F: Fail, W: Warning, R: Removal, A: Addition, C: Change.

Step Description Elapsed Time Result
1 All Upload 00:00:29 5147 F:0 . W0
b All Download 00:00:34 5147, F0 W0
3 Compare 0o:00:.02 RD _AD.C3 Q

Click on th & icon to view the verification log. This will display card removals, card
additions, and database changes.

— Upload/download failure

If the upload/download fails, an error message will be displayed and the upload/download will
be cancelled.

NOTE

Caution when uploading
A - When uploading a database, the card slot configuration of the user’s PC database should be
CAUTION identical to that of the active key phone system’s card slot configuration.
- It may be necessary to reboot the OfficeServ 7000 Series system after the upload process (a
message will be issued.) To protect system data from being accidentally deleted, please
ensure that the MP10/MCP/MP40 card’s backup switch is set to [ON].
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File Menu

The [File] menu provides functions such as opening and closing the user database, importing and

exporting an Excel file, and exiting the IT application.

Cpen Database  Chrl+O
Clase Database

Import | Export

Exit

Using the [File] Menu

The [Open Database] and [Import/Export] sub-menus can only be used while in the off-line
NOTE mode.

© SAMSUNG Telecommunications America, L.P. 03/2008
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Open Database

The [Open Database] sub-menu can be used to open an OfficeServ 7000 Series database file. This
can only be used while the IT is in the off-line mode. Once the [File] = [Open Database] sub-
menu is selected the following window will be displayed:

2|
Look in: I@User j = il

057100_J54,1UD

File name: I j Open I
j Cancel |

" Files of type: | Inctallation T ool Uiser Files[ILD)
A

Select a database file (.IUD) then click the [Open] button. The following <Login> window will be
displayed (Default password is 4321.)

x

Fassword I
Enable ITenanH '|

Ok I Cancel |

Enter the correct password to open the selected database file.

Entering the password

O
:Yz_ After three unsuccessful login attempts, an error message will be displayed and the IT
cHEck  application will close.
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I Close Database

This sub-menu is used to close an OfficeServ 7000 Series system database file. This can only be
used while in the off-line mode. Click on the [File] > [Close Database] sub-menu to close an
opened database.

I Import/Export

This sub-menu is used to import or export a specific feature block from or to an Excel file (*.xls.)
This can only be used while in the off-line mode. Click on the [File] = [Import/Export] sub-menu
and the following window will be displayed:

=1l
8ol
e | =] = || Excet | R =]
Kind [ =] || shest| =15

Vi
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Importing the Excel File (Example)

Below is an import example. The 2.4.2 Port Common Data’ is used to illustrate this procedure.

1

Click on [...] to set the appropriate paths for the database file and the Excel file.

Errr s

=1l x|

8o
DB |oElectioniosiinstalation_TaolWserDS7100_USAIUD »| [l | | Excel |p\zn_n7n723 Installation_Tool(SourcelUserimport s =] - [l
Kind  [24.2 Pert Common Diata =] | | sheet [2 4 2 Pon Comman Data s
= A [B & o [E =
LT bl Il E R o TelMumber Name Made Busy MOH | LCR
301 ide  TONWE [ 1]¥es an Idle TONE
02 idle  TONE [[ 2|ves 302 Idie TONE
303 idle  TONE 7| 3|ves 303 Idle TONE
304 idle  TONE || d|Ves 304 Idle TOMNE
2m idle  TONE || 5|ves 201 Idle TOMNE
202 idle  TONE || B|ves 202 Idle TONE
203 Idle TONE | 7|Yes 203 Idle TONE
204 idle  TONE || B|ves 204 Idle TONE
701 idle  TONE || |ves 205 Idle TOMNE
702 ide  TONE [[ 10/ves 206 Idie TONE
703 idle  TONE || 11]ves 207 Idle TONE
704 idle  TONE || 12|ves 208 Idle TONE
205 idle  TONE || 13|ves 701 Idle TONE
206 idle  TONE || 14)ves 02 Idle TOMNE
207 idle  TONE || 15|ves 703 Idle TONE
208 Idle TONE | 16 Yes 704 Idle TONE
3601 Idle kil | 17)ves 705 Idle TONE
3502 Idle 71 | 18|ves 706 Idle TOMNE
3503 Idle In 18/ ves 707 Idle TONE
AENA Lol 271 2N Ves 7NA Idla TAKIE X
b I Nl [ s

Installation Tool User Guide

Select the page and sheet. In the Excel section, select the field name and whether to include it
in the document.

Errr s

=1l x|

B0 &
DB |C\Program Files\Samsung Electioniostinstallation_Tool v| || | | Excel [\Samsung Electroniosinstalation_ToohUserimportsis »] . |Igl
Kind  [24.2 Pert Common Diata =] | | sheet [2 42 Pon Comman Data s
= A [B & o [E =
LT bl badR Bo O TelNumb v] Nare Made Busy MOH | LCR
301 e TONE [[1[ves TONE
302 lle  TONE || 2'es TONE
303 idle  TONE —|| 3 ves [Name TONE
04 e ToNE || dves |MadeBusy TONE
201 e TONE || §Yes ||'cR (lace TONE
202 Idle  TONE || 6Yes |Call Priority TONE
203 Idle TONE | 7|es |Distinct DGP Tone TONE
204 de  TONE §ves |Distnct SLT Ring TaNE
701 e TONE || 9|ves [Distnct'M Ringkack TONE
702 Ile  TONE || 10/es 206 TONE
703 ldle  TONE || 11 ves 207 TONE
704 e TONE || 12ves 208 TONE
208 e TONE || 13 'ves 0 TONE
208 e TONE || 14ves 702 TONE
207 ldle  TONE || 18 ves 703 TONE
208 Idle TONE 16| ves 704 TONE
3501 Idla arl || 17]ves 705 TONE
3502 Idle 37 | 18] ves 706 TONE
3503 dle 371 18] ves 707 TONE
ABnA Tl 271 2N Yoo FNR. TNKFE
i | WOl 1
4
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3. Click on [Copy To Left] to move the document to the file section and then click the [Save]
button to save the database contents to the file.

Exit
This sub-menu is used to terminate the IT application. Click on the [File] > [Exit] sub-menu to
terminate the application.

Save changes on exit

When there is unsaved data, a ‘Do you want to save change(s)?’ message will be displayed:
NOTE Click on the [Yes] button to save the changes. Otherwise, click on the [No] button to discard
the changes.
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Option Menu

The [Option] menu consists of two sub-menus entitled Environment Settings and Language.

Enwironment Setkings
Language k

Environment Settings

Display
This sub-menu is used to configure the IT applications attributes such as color scheme and other

options which will be discussed in this section of the User Guide. Click on the [Option] >
[Environment Settings] sub-menu and the following window will be displayed:

13} Environment Settings ll
Display: 1 Miscellaneous ]
ABC DEF | [ [
ABC
abc
abc def
abc 123

Fixed Area Color Back... | Faont... |- Grid... |-
FieldAreaColor  Back.. | Fort. | oo |
Alternative Use ¥ Back.. H:I

Default |

Apply | Close |

Refer to the following table to configure the IT window.

Field Details
Fixed Area Used to set the title field’s background/text/line color.
Field Area Used to set the content field’s background/text/line color.
Alternative Use Used to set the repeated background color for the content field.
[Default] Button Used to apply default values to the IT’s window properties.
[Apply] Button Used to apply custom values to the window properties.
[Close] Button Used to close the Environmental Settings window.
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This menu is used to set additional information regarding the IT application’s environment.

13} Environment Settings ll
Display T Miscellaneous! ]

User File Falder Igram Files\Samsung Electronicsiinstallation_ToollUser J

System File Folder Im Files\Samsung EIedronics\lnstallation_ToDI\PngramJ

Default |

Focus After [Enter]

 Mext Field  Mext Record
& Diown Diraction * Right Diraction

v Mowve Page in same window

[” Open Page Circulatly in maximum of window

Apply Close

Refer to the following table to configure:

Field

Details

User File Folder

Used to set the initial location for the user database file
selection.

System File
Folder

Used to set the initial location for the system application file
selection.

[Default] Button

Used to apply default values to IT’s file location properties.

Focus After Used to set the cursor position after pressing the Enter key

[Enter] within a page.

Move Page ... Used to select whether to display the target page in the current
page when moving to the target page.

Open Page ... Used to select whether to display the target page in the oldest

opened page when the maximum (opened) page count is
reached.

[Apply] Button

Used to apply custom values to the option properties.

[Close] Button

Used to close the Environmental Settings window.
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Language

Select the language to be displayed in the IT application using the [Option] = [Language] sub-
menu. Currently the available languages choices are English, Korean, Russian, German, and Italian.

1. From the [Option] - [Language] sub-menu select which language to use.
If a new language is chosen, the following message will be displayed:

Language =
@ Do you wank ko change the display language ?
Yes I Mo |

2 To change to the selected language, click the [Yes] button.
If the [Yes] button is clicked the following window will be displayed:

Cre— x
-
1 If wou apply the changed language, Restart the program.
o |

3. Click on the [OK] button to complete the language choice and reboot the IT application.
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The [Util] menu consists of the File Control and Database Comparison sub-menus.

File Conkrol

DE Comparison

File Control

To upload or delete

a file (OfficeServ 7000 Operating System, Database, T1/PRI version, Startup,

etc..) on the key phone system’s Smart Media, MMC, or SD card, click on the [Util] = [File

Control] sub-menu.

The following window will be displayed:

x|
- Storage

Mo| Kind | FileMame / | Size | Date [ fa]

1| AP AP10V407PKG | 3152001 07.07.02%407

2| CS CS10v407PKG 1332484 07.07.02v407 M Delste |

| 3| DR DRIOVAOZPKG 1146408 07.07.02v407 M

| 4| M3 MS10VM07PKG 1589172 07.07.02v4.07

§| RD  RD10v407PKG | 5014383 07.07.02v407 R BT Change|N||

- Information

Used [ 652778959 Byta(s)  Tatal [ 256,901,120 Byts(s) . .

System 1D 057100 Festart [ Enable ] This window shows the
= Erng < | ontents of the media card.
File Name| |_|

See[ IByets Dme[ ] Uplosd |

’, Information

Name [ ] Version | | Date | |

Festart |

Close |

Refer to the following table to use the File Control:

Field

Details

[Refresh] Button

Used to refresh the system file index.

[Delete] Button

Used to delete the selected file.

[Change INI]
Button

Used to select which initialization file to use during the system
startup. The current file is displayed as blue within the index.
You must check the box in the INIT field to modify the
selection.

[Restart] Button

Used to restart the system with the new application.

[Close] Button

Used to close the File Control window.

[Upload] Button

Used to move the selected files from the IS Tool to the
OfficeServ 7000 Series key phone system’s storage Media.
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@ Using the [Change INI] button
The [Change INI] button can only be used in OS7100.

NOTE

Uploading the Application File (Example)

1. Click on [...] and select the location (path) and name of the file to upload to the key phone
system’s Smart Media, MMC, or SD card.

@ Only 1 file may be uploaded at a given time

NOTE

w; File Control [0S7100_Local] ll

- Storage

Mo| Kind | FileName / | Size | Date [ 2] Refresh |
AP APTOVADZPKG 3152001 07.07.02%4.07

CS  CSI0VA07.PKG 1332484 07.07.02v4.07 Delete |
DR DRIDV4O7PKG 1146408 07.07.02v407 M

M3 MEN0VEDPFKG 1698172 07.07.02%4.07

FD  ROOOW4D7FKG  RO014383 0707024407 W BT ChangeINll
— Information

Used £5,277.952 Byte(s) Tatal | 256,901,120 Byte(s)
System 1D 057100 Festart

~ Program
File Mame |nd SettingsiadministratotDeskiopWWs10%406.PKG |

Size E26.64H Byte(s)  Date [ 2007-07-23 15:30.53 Upload |

’, Information

t_1'||_|>.|t_,..7|r\3|—A

MName 0S 7100-°WEB ‘“ersion [ V406 | Date [ 070612 ]

Festart | Close |

2. Click on the [Upload] button to upload the file.

3. Upon successful completion of the file upload, the following message will be displayed:

x
/_i The file(s) is uploaded successfully

Total Elapsed time [ 00:00:49 ]
== Transfer time [ 00:00:46 ]
= Write time [ 00:00:03 ]

Uploading the file
The ‘file upload’ feature simply puts software on the media card. In order to upload a file to the
noTE  various OfficeServ 7000 system cards, ‘MMC 818’ must be used.

7l
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DB Compare

With the DB Compare feature, dowloaded OfficeServ 7000 Series databases may be compared to
each other. This functionality makes it simple for system administrators to verify and pinpoint
modifications in the system programming from one database to another.

While in the off-line mode, this sub-menu is used to compare 2 OfficeServ 7000 Series system
databases from the user’s PC.

1. Click on the [Util] - [DB Comparison] sub-menu. The following window will be displayed:

22 DB Comparison |Z‘b—_<|
Q

[i . T ol

Change(s] #1 #2 Size

2. Click on the J icons to select the appropriate OfficeServ databases.

£ DB Comparison

| == [T <l
= n *
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3. Oncea J icon is selected the following window will open.

Open Database #1 [ @

Look in: |B My Documents j = -
_2_ (C2)Camtasia Studio
k- @My Music

My Recent E‘My Pictures

Documents [)5naglt Catalog
?-L' () Updaters

[C5ywebCam Center
Desktop (=] class ©o Switch.1uD
= testz.10m
[ testz.10m
= test. 100

2=

iy Documents

My Computer

@

My Network. File: name; | j Iﬂl
Flaces
Files of type: |Installalion Tool User Files{"1UD] j ﬂ

4. Select a database and then click the [Open] button

Open Database #1

Loak i |E'| ty Documents j =5 B

Ty () Camtasia Studio
. My Music
My Recent |2} my pictures
Docurnents

() 5naglk Catalog
?-L' () Updaters
() webCam Canter

Desktop Class CO Switch, 1D

= test.ILID
My Documents
Fdy Computer
My Netwark, File name: |test2 j Open
Places
Files of type: |Installati0n Tool User Files["1LD) j Cance

© SAMSUNG Telecommunications America, L.P. 03/2008 37



Installation Tool User Guide

5. Once the 2 databases have been selected click on the 8 | icon to compare the databases

2. DB Comparison D

A

6. Once the data base compare process has been completed the following window will be
displayed:

DB Comparison

g olanm

Changels) | # [ #2 [ Size |~
2.1.0. System Selection 2.1.0. System Selection = |
2.1.1. System Information 2.1.1. System Information =
2.1.2. LAN Parameter 2.1.2 LAN Parameter =
2.1.4 License Key 2.1.4 License Key = B
2.1.5. System Options 2.1.5. System Options =
2.1.6. S%Mi Options 2.1.6. S%Mi Options =
2.2.0. Cabinet Information 2.2.0. Cabinet Information
2.21.LCP Card 2.2.1. LCP Card
2.2.2. MGI Cards 2.2.2 MGl Cards
2.2.3. SWMiCard 2.2.3, SWMi Card
2.2.4. WLl Cards 2.2.4 WLl Cards
2.2.5. DLI Cards 2.2.5 DLI Cards
2.2.6. 5L Cards 2.2.6 5Ll Cards
2.2.7. Analog Trunk Cards 2.2.7 Analog Trunk Cards
2.2.8. Universal Trunk Cards 2.2.8 Universal Trunk Cards
2.2.10. PRI Cards 2.2.10. PRI Cards
221111 Cards 221111 Cards -
2.3.0. Virtual Cabinet Information 2.3.0. Virtual Cabinet Information =
2.3.1. Virtual DGP 2.3.1. Virtual DGP
2.3.2. Virtual SLT 2.3.2 Virtual SLT
2.3.3. Desktop ITP 2.3.3 Deskiop ITP
2.3.4. Mobile WIP 2.3.4. Mobie WIP
2.3.5. Standard SIP Phone 2.3.5. Standard SIP Phone
236 IP-UMS 236 IP-UMS
2.3.8. Virual GCONF 2.3.8 Virual GCONF 2
990 1D Teuelen 990 1D Teuelen )

0 removal(s] - 0 addition(s] - 15 change(s) él
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The alignment method may be changed using the [Window] menu.

Cascade

Tile Harizantally
Tile Werkically
arrange Ieans

laseall

Wimd o Lisk F

Cascade
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Click on the [Window] - [Cascade] sub-menu to arrange the windows in a cascading style as

shown below:

{33 Installation Tool i 1ol x|

System File Option Utl ‘Window Help

[2-R|% S¢|ww R-|B-B-

oo [l

__

Potase | Cudde |

Exp 2nu

=) 2. Configuration -
1--[Z) 21 System Configuration
211, System Infomation
2.2 LAN Parameter
21.3 System Time
214, License Key
215, System Dptions
- 21.6 SMi Dptians

21.7. Connect User Proflle
- [B) 2.2 Cabinet Configuration
2201 Cabinet Information
221, LCF Card
- 22.2 MBI Cards

223 SVMiCad
- (E8l 2.3, Vitual Cabinet
: 230 Virual Cabinet Infomatio
- (&) 2.4, Port Configuration
: 241, Port Information

4l

&8 242 Fat Enmmim Dats _,j
»

ystem Infomation 1ol
AN Parameter -1of x|

|| r—
B & o|Ea|d

=lofx|
=Dl xi
Il & B

Itern

Feature

Licanse Key

License Status
Mewrs Allow

Soft Phone

Soft Phone
Soft Phone

On Chip (CPLU)

LicenseKey -

Online | 0S7100_Local [LAN] 10.0.0/0S7100 | USA

| '07.07.02 va.07

7/23/2007 | 3:26PM
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Click on the [Window] = [Tile Horizontally] sub-menu to tile the windows horizontally as shown

below:

{0} Installation Tool
System File Option UHl indow Help

=10l x]

|¢-4/ %/ S22 p3-|%-B-|0|0 =

Posase | Covkss | =
B (&8lol¢es & [[sm@[n Ty
BE

=--(E2) 2. System Configuration Year =
3 ? Current Time !
2.1.1. System Infemation Valus

2, Configuration

2007 o
2.1.2. LAN Parameter | =1 LI_I
2.1.3. System Time
214 lose Koy REE
2.1.5. System Dplions B & 0led & || s a o
2.1.6. 5YMi ptions
2.1.7. Connect User Profie [212]

--(88) 22 Cabinet Configuration ltem Valug

2.2.0. Cabinet Infomiation IP Address 100.05
2.21. LCP Card Gatewsy 10.0.01

222 MGI Cards

223 8YMi Card i [=] B3}
B 273 Vitual Cabinet N N
230 Vitual Cabinat Informatio
=& 24 Pan Configuation
] 241, FortInformation s Ll
(BB 24.2 Port Commen Data J;I S T 2208
4] [ MCP DIF Switch 10000000
Online | 057100 Local [LAN] 10.0.0[057100 | USA | '07.07.02 v4.07 723/2007 | 325PM

| Tile Vertically

Click on the [Window] > [Tile Vertically] sub-menu to tile the windows vertically as shown

below:

@ 1nstallation Tool

—[Bx]
System Fle Optin Utl Window Help
I3-Gi%Se/ww - &-B-|0|6 )
Port Base e =10l =1olx| =lolx|
@8 ol¢erd]|l@e@olesd ¢[|me & oles|]
] il il
21.System Corfigution N Tiern Value| | [fem Vel
21.1. System Infomation Value| IP Address 000/ System Type 15710]
21.2 LAN Parameler Gateway 000 | [MCPDIP Switch 0000
211.3 System Time o ¥ Subnet Mask. 2852 MCP Version 7.02|
21.4. License Key 2 Mac Address i1122: MCP EPLD Version V3
21,5, System Optons 3 PublicIP Address 100f| | [MCPPCBVersion Vo
(&) 21.6.5VMi Optons 4| Public Port 0 Modem EPLD Version Vo
21,7, Connst s Profle Daylight Saving Time |5 1P Type sate C| Moclem PCB Version Vo
22 Cobinet Configuation 6 Systern Resat o Modem Exist No
22,0, Cabinet Informatin z_| Free Speed Black 130
221.LeP Card 7: E’EE E‘D E“”Et igg
res Log Bloc!
222 MGl Card 4
o 10 Free TMSG Station 2
s Free GCONF Stati
2.3 Vitual Cabinet System Time Option 2 Lkl

230, Vitual Cabinet Informato
24, Por Confgraion
241, PortInfamation
24.2 Port Common Data
(&) 24.3.CLI Send Number
25 Staon Pon erfiguition
(@) 251 Staton Dt
25.2 Staton On/Df Data
25,3 Customer On/0ff
254, Preset Forward
255 Hatline
25.6.0LI Data

(1 757 e

i} |

Online |057100_Local [LAN] 10.00(057100 | usa [ ‘07.07.02v4.07 712372007 | 3:26 P
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Arrange Icons

Click on the [Window] > [Arrange Icons] sub-menu to minimize all windows and arrange them
as shown below:

{3 Installation Tool B ol x|

System File Option Utl ‘Window Help
|12-%|% 32w 3-|B-B-/10|0 | oA o
FortBase | CardBase
= 2nu ltem(s)
g 2. Configuration -
B (&) 21 System Configuration
21.1. System Infomation
21.2 LN Parameter
213 System Time
21.4, License Key
215 System Options
~{E) 215 SVMiDptians
21.7. Connect User Proflle
£ (&) 2.2 Cabine! Configurstion
2.20 Cabiet Information
221 LOP Card
2.2.2 MG Cards
22.3 SVMiCard
£ (S8 2.3 Vitual Cabinet
; 230 Vintusl Cabinet Infomatic
(&8 2.4, Port Configuration
: 241, Port Information

) 242 F’ullEummimDala _,;I
>

&0 x|
) 210/ sioix]
| '07.07.02 V4.07 772372007 | 3:27 PM .

4

Online | 0S7100_Local [LAN] 10.0.0/0S7100 | USA

Close All

Click on the [Window] = [Close All] sub-menu to close all opened windows.
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Help Menu

The [Help] menu is used to display the information of the Installation Tool.

Abouk, ., |

Information

This sub-menu displays additional information such as the IT application’s version, copyright,
policy/permission and date. Click on the [Help] = [About...] sub-menu to display the following
window:

T About El

i) Installation Tool
Yi.1.420080314

Warning : Thiz computer program iz protected by 0K
copyright law and intermational treaties.
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CHAPTER 4 Application Window and
Programming Example

In this chapter, an introduction to the Application Windows, which are used to set up the OfficeServ 7000
Series system from within the IT, is provided. In addition, examples of some of the feature blocks are also

provided.

Feature Block Menu Windows

System modifications are accomplished by changing parameters within each feature block menu
window. Below is an example taken from feature block menu 2.1.1:

211,

B Glolead [t h F o

ltem

Walue

System Type

MCP DIF Switch

MCP Wersion

MCP EPLD Wersion

MCF PCE Yersion

tModem EPLD Version

Maodem PCB Version

haodem Exist

Free Speed Block

Free CID Block

Free Log Block

Free TMSG Station

Free GCOMNF Station

os7100
10000000
07 0614 %4 06
3
Wi
w0

Wi

<o
130
200
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Feature Block Menu Window Icons

Below are details of the Feature Block Menu window icons:

Details

Save: Used to save to a file in off-line mode, or to upload a file in on-line mode.

Reload: Used to refresh a page.

Print: Used to display a preview of the page to print.
(Click on [Print] from the preview window to print.)

Close: Used to terminate the feature block window.

Previous: Used to move to the previous page.

Next: Used to move to the next page.

Add to Bookmarks: Used to add the current page to the bookmark.

Cut: Used to cut the selected text from a field.

Copy: Used to copy the selected text from a field.

Paste: Used to paste the previously cut/copied text to another field. You cannot paste if the data on
the clipboard and the target field are of different data type.

Search: Used to search within a field.

Repeat: Used to enter a series of consecutive numbers in the selected field. You can use ;' to
define the intervals.

(o | 8 B o< | & ¢ O M| 2 MO

Focus after [Enter]: Used to display and change the current value for the cursor position after
pressing the Enter key. Users can select between right and down.
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Menu Bookmark

The Bookmark feature is for storing IT menu choices that are used extensively. This way they are

quickly loaded by the phone system administrator. In order to add a Menu Bookmark, do the
following:

Click on a feature block to open.

e
System File Option Ut ‘Window Help
|2-s/s Se(mmic-|B®- (06 |4

PortBase | CardBase Al

2.1.1. System Infomation

u Itemfs]

\
2. Configuration
(@) 3 call Routing
() 4. Group & Table
([T 5 Features
€. System Conlrol

-G

Online | 0S7100_Local [LAN] 10.0.0/0S7100 | USA

'07.07.02¥4.07  >> |/T_ROUTINE-110. INS_[7/23/2007 | 431PM

Once a feature block is open, click on the Bookmark &; pull-down menu and select [Edit

Bookmarks...]. Once this is done the following window will open. Use the Item pull down menu
and select the feature block to be added.

W oookmarks

Delete |

o Kind Diescription

n Infomation

lterm = Add

Once a feature block is selected, click the [Add] button.
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Once the Menu Bookmarks are defined, select the Bookmark &, pull down menu and select the
defined IT menu to open.

|%-B-olo

Edit Boakmarks...

2.1.3. System Time

2,10, System Selection
2.1.2. LAM Parameter

2.1 L System Information

History

To display the history of the recently opened IT menu blocks select the pull down menu next to the

ESB Icon.

{13 Installation Tool - [System Time] K

€9 System File Option Ul Window Help

=10l x|
=181 x|

Exp: henu f

B 2. Configuiation

[$-G 85S¢ ®»® g B -Bjolo

2.1.3. System Time
2.1.2, LAN Parameter
2.1.1, System Infomation

=

=

El

EEEIEE

=--(&W) 21. System Configuration

2.1.1. System Infomation
212 LAN Parameter
2.3, System Time

1.4, License Key
215 System Oplians
2.1.6. SYMi Options
~--{EB) 21.7. Connect User Profile
(&) 22 Cabinet Configurstion
2.2.0. Cabinet Irfomation
221 LCPCard
22.2 MG Cards
- {EB) 223 5YMiCard
=] 23, Vitual Cabinet
---{EB) 2.3.0. Virtusl Cabinet Informatio
2.4, Port Configuration
---{EB) 241 Port Infarmation
1 (B 242 PnrtEnmmTr\Data _l;l
4 5

-0

Value

Year
2007

Man

Daylight Saving Time

Zw[m|[m o] n]w]r]—=

Year
2007
2008
2003
2010
2011
202
2013
2014
205
2016

Star|

P S S S S

System Time Option

4

Auto Update ISDN Time

Walue
Off

»

Online | 057100_Local [LAN] 10.0.0[057100 | usA

|07.07.02 va.07

7/23/2007 | 3:29PM

Click on the &y and [Del History...] then the [Yes] button to delete the history.

istory

& Do you wank to delste all ?

‘fas Mo |

Click on the [OK] button to complete the deletion process.
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Feature Block Programming (example)

This section illustrates a programming example of a feature block. The 2.4.2 feature block (Port
Common Data) is used to illustrate this procedure.

1. Click on the [System] > [Connect] sub-menu. The following window will be displayed:

) Installation Tool i =10l x|

System File Option Ukl Window  Hel

#-% %/ Se/ew g &H-B-|0|S A o8
PonBasg | CadBam |

B 2. Configuiation -
[E] 2.1. System Configuration
21.1. System Infomation

2.1.2. LAN Paramster

2.1.3. System Time
2.1.4. License Key
2.1.5. System Dptions

< {EB) 215, S¥Mi Dilons
b=

Online | 057100_Local [LAN] 10.0.0[057100 | usA

|07.07.02 va.07

7/23/2007 | 318PM

2. From the main IT window, click on the [2 Configuration] - [2.4 Port Configuration] >
[2.4.2 Port Common Data] feature block to display the following window:

i
9 System Flle Option Utl Window Help =8l x|
2-2/2/3¢/0w - &-B-|0|0 e
PotBase | Cadbae | Be(glo e+ [ppR[alg> |
& Configaion A | retrumber  |Bom P e =
2.1. System Configuration Station Name
([T 22 Cabinet Configuration 201 371 % On off
(Z) 23 Vitual Cabinet 202 371 On off
(T3 24. Port Configurstion 203 n On Off
=] 25, Stalion Pait Configuration 204 n On off
251, Station Data 3401 Enl On oft
252 Station DOl Data il skl on 0
253, Customer On/0ff Al L] o i
5.4. Preset Formard ::E; ;;1 8: gz
:Z :f: :;‘:a 3406 il On off
3407 3n On off
- 3408 371 on of
([T 26 Tk Por Configurstion 409 37 on o
(@) 27 vitual Fort Configuation 30 7 On of
([T 28 Numbeiing Plan 3an 37 On off
& (E) 2 calRoutng 312 n On o
() 4. Group 8 Table | {2413 ELd on off
& (B 5 Feaues 3414 kL on off &
il JF) 6 Guctam Camieal X = K
Online | 057100_Local [LAN] 10.0.0[0S7100 | USA | '07.07.02V4.07  [Tel Number] 71232007 | 4:32PM
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3. Set each parameter appropriately and then click on the & icon to save changes.

4. Click on the |i| to close the feature block.

Displaying the OfficeServ 7000 Series System Properties

When a feature block is open the IT displays the corresponding OfficeServ 7000 system field
properties on the very bottom of the IT window. System type, IP address, connection method,
system software version, time, and date are displayed as shown below:

| Dnline | 0S7100_Local [LAN] 10.0.0 0S7100 | USA | '07.07.02V4.07 [Read Only] 7/23/2007 | 432PM

Error on Saving

The IT application will display all available values regardless of the system type or local settings.
When the user selects an incorrect value, the following <Warning Information> window will be
displayed:

|
Kind fau =
Displayed temis) 141
; Error
Kind Type | Indlex | In] |Descripti0n
242 | PortMNumber 16 (T:301) 0x60 Irvalid Device

Close |

Warning Information window

@ The <Warning Information> window is displayed when an error occurs during the save
NOTE  process while in the on-line mode.
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The [Port Base] tab opens a window consisting of the search utility and the IT feature block menus.
It is used navigate to IT menus and to perform searches based on MMC number or IT menu number.

Port Base T Card Baze ]

Expand Al Menu lte

. 2 Eonflguratlon

o [ER) 21 R SWMINntinns

[0

2.1. System Configuration
. 2.1.0. Spstem Selection
2.1.1. Sypstem Information
21.2. LaM Parameter
21.3 Spstem Time
2.1.4. License Key

2.1.5. Spstem Options

| £

| >

Refer to the following table to configure:

Field Details

Expand All Used to display all the IT feature block menus.

Menu ltem(s)

Quick This pull down menu is used to display all the IT feature blocks.
You can quickly jump to feature block after selecting from this
field.

Search Used to search from the menu/MMC content.

Include field Used to select whether to include the title within the page (in

item addition to the menu title) in the search.

Select Used to display the search results. Click on a feature block to

open the corresponding parameters.
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Contains a list of all the feature blocks. Using the keyboard, type 2° > . 2> 2> 2> > 2> 0’ to
select the corresponding ‘2.2.0 Cabinet Information’ page. Press the m button to open the feature

block.

M Ex:pand &l Menu ltem(s)

2812.1.6. SWMI Options

2.1.2. LAN Parameter
2.1.3. Systemn Time

2.1.4. License Key
2.1.5. Systern Options

2.1.7. Connect User Profile
2.2.0. Cahinet Information

7l

NOTE

Selecting the page

When selecting with the mouse or the cursor key, you may click on the ) button on the right
to open the corresponding page.

Search (by Menu)

Select [by Menu]. In the [Search] field, enter the keyword and click on the &) button. The
corresponding menu names are displayed in the [Result(s)] box.

W Expand Al Menu [temiz) -]

- Quick

>> Select WEERE)

27115 Free TMSG Station
211> Free GCOMF Station
21.6.»> BRI Station

When the [Include Field Item] is selected, the search results include the menu names and the titles
within the page.
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Tooltips are useful icons that appear when a user hovers over expanded menu items. The
information displayed associates the menu item with one or more MMCs used when programming a

specific step.

+ @ 2. Configuration
= 3. Call Routing
= 3.1. DutaoinalLCR]

+ @ 3.2, Incoming

[

311,

CR Options

—uibina ok

32

3.1.1,=> MMCZ10,501,716

313
3.1.4. Routing T able
315 Modify Digits
2.1.6. Second LCR Digits

Search (by MMC)

Select the [by MMC] radio button. In the [Search] field, enter the desired MMC number and click
on the &1 button. The corresponding menu (with the MMC number) is displayed in the [Result(s)]

box.

B Expand All benu lte

o b

& Field tem

>> Select | NEEE

51515 MMCI00.107.704
5.15.1.»> [100] 5TH LOCK

When the [Include Field Item] is selected, the search results display the specific field within the
MMC number as well as the menu.
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Card Base

The [Card Base] tab displays the configuration of the current system’s configuration.

Port Base T Card Base
Bsysem

LP40 TEPRIZ TEPRIZ
MP40 TEFRIZ TEFRIZ
TEPRIZ TEFPRIZ TEPRIZ
TEFFRI2 G164 GFLIMT

LP40 1EkWSLI 1EkWSLI
16DLIZ

SWMIZOE12] TEFRI TEFRI
GwIMT GFLIMT GFLIMT

fd_ahinet 3

LP40

Clicking the icon to the left of a cabinet number will display the cabinet information as shown
below:

m Cabinet Mumber |1 A

lterm Yalue
LF “ersion

Fan Status

Option Board 1

Option Board 2
Option Board 3
Cahinet EFLD Yersion
Cahinet PCE Version
LF EFLD Version

LF PCE “ersion
External Ringer 1
External Ringer 2

Slot Mumber 1 2 3 4
Previous Card
Previous Service 1

Previous Service 2
Previous Service 3
Current Card
Current Service 1
Current Service 2
Current Service 3
Card Status

Card Versian

DIF Switch

Option Board
EPLD Yersion
FCB “ersion
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The phone system administrator may also click on a card to get the card’s information as shown

below:

Slot

Channel Mo | FPort Mumber |Dewvice

o0~ [ 00| U0 s | Lo | PO —

11
12
13
14
15
16
17
18
19
20
21
22
23

928
929
930
3
932
933
934
935
936
937
938
939
340
941
94z
943
944
945
946
947
945
349
950

PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
FRITRLIMNE
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK
PRI TRUNEK

TenantNo

1

Tel Mumber

Unlike the [Port Base]| tab, the [Card Base] tab only displays the ports corresponding to the given
card. The corresponding menu is also displayed on the upper section of the window.

N

NOTE

Using [Card Base]

[Card Base] is enabled in on-line mode.
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CHAPTER 5 MMC and Installation Tool Cross
Reference

The following table displays a cross reference for MMC codes and Installation Tool codes. Locate the

appropriate MMC or Installation tool code needed to be referenced.

MMC | Program Name Installation Tool Menu 7100 | 7200 | 7400
100 STATION LOCK 5.15.1 v v v
101 CHANGE USER PASSCODE 5.15.1 v v v
102 | CALL FORWARD 5.15.6 v v v
103 | SET ANSWER MODE 5.15.2 v v v
104 STATION NAME 2.4.2,515.1 v 4 4
105 STATION SPEED DIAL 5.15.7 v v v
106 | STATION SPEED DIAL NAME 5.15.7 v v v
108 STATION STATUS 2.4.1,2.8.0,6.2.1 v v v
109 | DATE/TIME DISPLAY 5.15.2 v v v
110 STATION ON/OFF 5.15.2,5.15.3,5.15.4 v 4 4
111 KEYSET RING TONE 5.15.5 v v v
112 ALARM CLOCK 5.15.8 v v v
114 STATION VOLUME 5.15.5 v v v
115 SET PROGRAMMED MESSAGE 5.15.9 v 4 4
116 ALARM REMINDER 5.15.8 v v v
17 TEXT MESSAGE 5.15.10 v v v
118 CONFERENCE GROUP 5.15.11 v v v
119 CALLER ID/ ANI DISPLAY 5.15.3 v v v
120 LARGE LCD OPTION 5.15.12 v v v
121 STATION LANGUAGE ASSIGNEMENT 5.15.3 v v v
122 SPOT INFO SPD 5.15.2 v v v
125 EXECUTIVE PRESENT STATE 5.15.13 v 4 4
199 | SHOW LICENSE STATUS 214 v v v
201 CHANGE CUSTOMER PASSCODE 5.13.1 v 4 4
202 CHANGE FEATURE PASSCODE 5.13.1 v v v
203 | ASSIGN UADEVICE 5.13.1 v v v
204 COMMON BELL CONTROL 2.2.1 v v v
205 | ASSIGN LOUD BELL 2.2.1 v v v
206 | BARGE-IN TYPE 5.13.1 v v v
207 | VMAA PORT 257 v v
208 | ASSIGN RING TYPE 257 v v v
209 ASSIGN ADD-ON MODULE 423 v v v
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MMC | Program Name Installation Tool Menu 7100 | 7200 | 7400
210 CUSTOMER ON/OFF PER TENANT 3.1.1, 334, 521, 522, | vV v v
5.14.1-8

211 DOOR RING ASSIGNMENT 3.2.7 v v v
214 DISA ALARM RINGING STATION 5.13.1 v 4 v
217 STATION PAIR 4.2.1 v v v
218 RELAY TYPE 2.2.1 v

219 TRAFFIC REPORT PRINTOUT 5.13.1 v 4 v
223 ISDN SERVICE TYPE 2.5.7 v v v
224 | AUDIO PROMPT 5.13.1 v 4 v
225 IP-UMS/IVR 274 v v
300 CUSTOMER ON/OFF PER STATION 24.2,252-7 v v v
301 ASSIGN STATION COS 4.7.1 v v v
302 PICKUP GROUPS 2.5.1 v v v
303 | ASSIGN EXECUTIVE/SECRETARY 422 v v v
304 | ASSIGN EXTENSION/TRUNK USE 51.2,51.3 v v v
305 | ASSIGN FORCED CODE 451 v v v
306 HOT LINE 255 v v v
308 | ASSIGN BACKGROUND MUSIC SOURCE | 2.5.6 v v v
309 | ASSIGN STATION MUSIC ON HOLD 242 v v v
310 LCR CLASS OF SERVICE 2.4.2 v v v
312 | ALLOW CID/ANI 2.5.1 v v v
314 | ASSIGN STATIONS/STATION USE 251,514 v v v
315 CUSTOMER SET RELOCATION 6.3.6 v v v
316 PRESET FORWARD NO ANSWER 254 v v v
317 | TIME/COST 5.15.4 v v
320 BRANCH GROUP 2.5.1 v v v
321 SEND CLI NUMBER 243 v v v
324 SLI GAIN 5.4.5 v v
326 RBT MSG 2.5.1 v v v
327 MMS SERVICE 5.15.14 v
400 CUSTOMER ON/OFF PER TRUNK 26.2,26.5, 322 v 4 v
401 C.0./PBX LINE 26.2 v v v
402 | TRUNK DIAL TYPE 2.6.1 v v v
403 TRUNK TOLL CLASS 485 v v v
404 | TRUNK NAME 242 v v v
405 | TRUNK TELEPHONE NUMBER 2.6.1 v v v
406 | TRUNK RING ASSIGNMENT 3.2.1 v v v
408 | ASSIGN TRUNK MOH SOURCE 242,322 v v v
409 | TRUNK STATUS READ 2.4.1,28.0,6.2.1 v v v
410 | ASSIGN DISA TRUNK 322 v v v
411 T1 SIGNAL 2.6.9 4 v
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MMC | Program Name Installation Tool Menu 7100 | 7200 | 7400
412 TRK SIGNAL 2.6.6 v v
414 | ASSING CALLER ID / ANI TRUNKS 265 4 v v
416 E&M/DID RING 26.4 v v
415 REPORT TRUNK ABANDON DATA 2.6.2 v v v
417 | TRK TMC GAIN 5.4.4 v v v
418 | TRUNK GAIN CONTROL 5.4.3 v v v
419 DISTINCTIVE RINGING 242 v 4 4
420 ANI / DNIS OPTIONS 5.13.1 v v v
421 TRUNK COS 471 v v v
422 COST RATE 5.12.1 v v v
423 SET H-TRK 26.6 v v
430 PRI CONTROL 2.6.8 v v v
432 CONNECTION STATUS 6.2.1 v v v
438 16 TRUNK GAIN 5.4.6 v v v
500 SYSTEM-WIDE COUNTERS 5.14.3,5.14.4,5.14.6 v v v
501 SYSTEM TIMERS 3.1.1,3.34,5.2.1,52.2, v v v
5.5.0,5.14.1-8
502 STATION-WIDE TIMERS 254,255,257 v v v
503 TRUNK-WIDE TIMER 2.6.1,2.6.3,26.5 322 v 4 4
504 PULSE MAKE/BREAK RATIO 5.5.0 v v v
505 | ASSIGN DATE AND TIME 2.1.3 v v v
506 TONE CADENCE 5.7.1 v v v
507 | ASSIGN RING PLAN TIME 431 v v v
510 SLI RING CADENCE 5.7.3 v v v
511 MESSAGE WAITING LAMP CADENCE 5.5.0 v 4 v
512 HOLIDAY ASSIGNMENT 432 v v v
515 | ASSIGN DAYLIGHT SAVINGS DATE 2.1.3 v v v
600 | ASSIGN OPERATOR GROUP 5.13.1 v v v
601 ASSING STATION GROUP 411 v v v
602 STATION GROUP NAME 411 v v v
603 | ASSIGN TRUNK GROUP 412 v v v
604 | ASSIGN INTERNAL PAGE ZONES 413 v v v
605 | ASSIGN EXTERNAL PAGE ZONE 413 v v v
606 | ASSIGN SPEED BLOCK 2.1.1,21.5,25.1 v v v
607 UCD OPTIONS 46.1 v v v
608 | ASSIGN REVIEW BLOCK 256 v v v
609 CALL LOG BLOCK 256 v v v
611 ALLOW TEXT MESSAGING 256 v v v
612 GROUP CONFERENCE ALLOW 256 v v v
614 SET ASTATION / C.O. LINE CALL GROUP | 5.1.1 v 4 4
615 MGI GROUP 414 v v v
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MMC | Program Name Installation Tool Menu 7100 | 7200 | 7400
616 MGI USER 222 v v v
701 ASSIGN COS CONTENTS 472 v v v
702 TOLL DENY TABLE 4.8.1 v v v
703 | TOLL ALLOWANCE TABLE 482 v v v
704 | ASSIGN WILD CHARACTER 483 v v v
705 | ASSIGN SYSTEM SPPED DIAL 440 v v v
707 | AUTHORIZATION CODE 453 v v v
708 ACCOUNT CODE 452 v v v
709 TOLL PASS CODE/SPECIAL CODE TABLE | 4.8.4 v 4 v
710 LCR DIGIT TABLE 3.1.2 v v v
71 LCR TIME TABLE 3.1.3 v v v
712 LCR ROUTE TABLE 3.1.4 v v v
713 LCR MODIFY DIGIT TABLE 3.1.5 v v v
714 DID NUMBER AND NAME TRANSLATION | 3.2.3 v 4 v
715 PROGRAMMED STATION MESSAGE 5.13.3 v v v
717 MY AREA CODE 215 v v v
718 UCD AGENT ID 462 v v v
719 IDLE DISPLAY 5.13.4 v v v
720 | COPY KEY PROGRAMMING 6.3.7 v v v
721 SAVE STATION KEY PROGRAMMING 6.3.8 v v v
722 STATION KEY PROGRAMMING 492 v 4 v
723 | SYSTEM KEY PROGRAMMING 4.9.1 v v v
724 DIAL NUMBERING PLAN 241,280 v v v
725 SMDR/HM OPTS 5.6.3 4 v
726 | VMAA OPTIONS 5.9.3 v v
727 | SYSTEM VERSION DISPLAY 2.1.1,2.2.0 v 4 v
728 CID / ANI TRANSLATION TABLE 326 v v v
729 RATE CALCULATION 5.6.3,5.12.2 v v v
730 | COSTING DIAL PLAN 5.12.3 v v v
740 | VM CARD RESTART 216 v v v
741 USER MAILBOX 5.9.1 v v v
743 AUTO RECORD 5.9.2 v v v
744 | VM DAY / NIGHT 216 v 4 v
745 | WARNING DESTINATION 216 v v v
746 | VM HALT 216 v v v
747 | VM ALARM 216 v v v
748 ASSIGN VM MOH 223 v v v
749 | VMIN/OUT 223 v v v
759 | CLIRINGING 325 v v v
763 IN DIGIT 3.16 v v v
764 DISA PASS 328 4 v
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801 CHANGE TECHNICIAN PASSCODE 215 v v v
802 CUSTOMER ACCESS MMC NUMBER 5.13.2 v v v
804 SYSTEM I/O PARAMETER 5.6.1 v v
805 LEVEL & GAIN 5.4.1 v v v
806 CARD PRE-INSTALL 2.2.0,6.3.1 v 4 4
807 ADJUST DIGITAL PHONE TONE QUALITY | 5.4.2 v v v
808 | T1 PARAMETER 26.9 v v
810 HALT PROCESSING 6.3.3 v v v
811 RESET SYSTEM 6.3.1 v v v
812 SET COUNTRY 215 v v v
813 HOTEL OPERATION 215 v v
815 | CUSTOMER DATABASE COPY 215 v v v
816 CONFERENCE GAIN 5.4.1 v v v
820 | ASSIGN SYSTEM LINK ID 3.3.1 v v v
821 Q-SIG TRUNK 26.8 v v v
822 VIRTUAL STATION TYPE 2.4.1,28.0,6.2.1 v v v
823 NETWORK COS 473 v v v
824 NETWORK DIAL PLAN 332 v v v
825 NETWORK OPTIONS 334 v v v
826 | CLOCK SOURCE 5.5.0 v v v
827 CRM DSP MODE 2.2.1 4
829 LAN PRINTER PARAMETER 5.6.2 v v v
830 ETHERNET PARAMETERS 2.1.2,5.6.1 v v v
831 MGI PARAMETERS 222 v v v
832 VOIP OUTBOUND DIGITS 5.2.3,5.2.4 v v v
833 | VOIP IP ADDRESS 525 v v v
834 H.232 OPTION 5.2.1 v v v
835 MGI DSP OPTION 5.2.9 v v v
836 H.323 GK OPTION 5.2.1,5.2.6 v 4 4
837 | SIP OPTIONS 522 v v v
838 PRIVATE IP ADDRESS 5.2.8 v v v
839 | SIPUSER 527 v v v
840 IP SET INFO 2.71,52.11,6.2.2 v 4 4
841 SYSTEM IP OPTION 2.1.4,5210,5.4.1,5.6.1 v 4 4
842 SIP STN INFO 2.7.2,6.2.3 v v
845 | WLAN PARAMETERS 5.3.1 v v v
846 | WIP INFO 27.3,625 v v v
848 | WLAN IP/MAC 5.3.3 v v v
849 | WLAN CONFIG 5.3.1, 6.3.11 WIPCLEAR v v v
851 ALARM MONITORING 2.1.5,6.1.1,6.3.9 v v v
852 SYSTEM ALARM ASSIGNMENTS 5.8.1,6.1.1 v 4 4
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853 MAINTENANCE BUSY 242,582 v v v
854 DIAGNOSTIC TIME 5.8.3 v v v
855 SYSTEM HARDWARE OPTIONS 2.1.1,22.0 v v v
856 TECH PROGRAMMING LOGS 6.1.2 v v v
857 VIRTUAL CABINETS 2.3.0,6.3.2 v 4 v
859 HARDWARE VERSION 2.2.0,2.2.1 v v v
861 SYSTEM OPTION 2.1.3,2.1.5,3.34 v 4 v
863 ACCESS NUMBER 333 v v v
865 FAN POWER CONTROL 220 v v v
890 PORT CLEAR 6.3.5 v v v
901 SYSTEM CODING 215 v v v
902 DIAGNOSTIC ITEMS 5.8.3 v v v
990 MP MEMORY DUMP 6.3.4 v v v
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